AN-1632 LP5521TMEV Programmable LED Driver

User's Guide

Literature Number: SNVA241E
April 2008–Revised September 2016
# Contents

1 Read This First .................................................................................................................... 5  
  1.1 About this Manual ........................................................................................................ 5  
  1.2 Related Documentation from Texas Instruments ......................................................... 5  
  1.3 FCC Warning ............................................................................................................. 5  
  1.4 If You Need Assistance ............................................................................................. 5  

2 Introduction ....................................................................................................................... 6  

3 Description of the LP5521 ............................................................................................... 6  
  3.1 General Description ...................................................................................................... 6  
  3.2 Features ...................................................................................................................... 6  
  3.3 Applications ............................................................................................................... 7  
  3.4 LP5521 Typical Application Drawing ......................................................................... 7  

4 LP5521EVM Hardware ....................................................................................................... 8  

5 LP5521 Evaluation Software ............................................................................................ 10  
  5.1 General ....................................................................................................................... 10  
  5.2 LP5521 Evaluation Software Installation ..................................................................... 10  
  5.3 Evaluation Software Uninstallation ............................................................................ 10  
  5.4 Graphical User Interface (GUI) .................................................................................. 10  

6 Examples .......................................................................................................................... 18  
  6.1 Starting up the LP5521 ............................................................................................. 18  
  6.2 Set R, G, and B LEDs ON ....................................................................................... 18  

7 Using Scripts ..................................................................................................................... 19  
  7.1 Register Access .......................................................................................................... 19  
  7.2 Parameters ................................................................................................................ 21  
  7.3 Loops ........................................................................................................................ 21  
  7.4 Command Reference ................................................................................................. 21  

8 Command Compiler ......................................................................................................... 23  
  8.1 Instruction Reference ................................................................................................. 23  
  8.2 Example Code .......................................................................................................... 24  

9 Evaluation Board Schematics .......................................................................................... 25  

10 PCB Layout .................................................................................................................... 31  

11 Bill of Materials ............................................................................................................. 32  

Revision History .................................................................................................................. 33
List of Figures

1 Evaluation Board Connectors and Setup ................................................................. 8
2 LP5521 Evaluation Board ...................................................................................... 9
3 Evaluation Software ............................................................................................... 11
4 Direct Register Access Dialog ............................................................................. 17
5 Top Level ................................................................................................................ 25
6 Microcontroller ..................................................................................................... 26
7 LP5521 (Device 1) ............................................................................................... 27
8 LP5521 (Device 2) ............................................................................................... 28
9 LP5521 (Device 3) ............................................................................................... 29
10 LP5521 (Device 4) ............................................................................................. 30
11 Top Overlay ......................................................................................................... 31
12 Layer 1 (Top, Signal) ......................................................................................... 31
13 Layer 2 (GND) .................................................................................................... 31
14 Layer 4 (Power) .................................................................................................. 31
15 Layer 4 (Bottom, Signal) .................................................................................... 31
EVM Warnings and Restrictions

It is possible to feed VDD voltage from external source to connector J2. It is important to operate this EVM within the $V_{DD}$ voltage range of 2.7 V to 5.5 V. The $V_{DD}$ voltage must never exceed 6 V.

Exceeding the specified input range may cause unexpected operation and/or irreversible damage to the EVM. If there are questions concerning the input range, please contact a TI field representative prior to connecting the input power.

During normal operation, some circuit components may have case temperatures greater than 60°C. The EVM is designed to operate properly with certain components above 60°C as long as the input and output ranges are maintained. These components include but are not limited to LEDs, linear regulators, switching transistors, Inductors, pass transistors, and current sense resistors. These types of devices can be identified using the EVM schematic located in the EVM User’s Guide.

When placing measurement probes near these devices please be aware that these devices may be very warm to the touch.

The white LEDs which are mounted on the EVM emit light which, at a high enough intensity, have the potential to be harmful to the eyes. To reduce the risk of eye damage TI recommends using engineering controls (for example, light-blocking screens or filters) or personal protection equipment (for example, light-filtering or blocking eyewear). Users should not look directly at any operating LED component regardless of LED color or intensity.
1 Read This First

1.1 About this Manual

This user’s guide describes the characteristics, operation, and use of the LP5521 evaluation module (EVM). This user’s guide includes a schematic diagram and bill of materials (BOM).

1.2 Related Documentation from Texas Instruments

LP5521 data sheet: LP5521 Programmable Three Channel LED Driver (SNVS441)
AN-1562 LP5521 Programming Considerations (SNVA205)

1.3 FCC Warning

This equipment is intended for use in a laboratory test environment only. It generates, uses, and can radiate radio frequency energy and has not been tested for compliance with the limits of computing devices pursuant to subpart J of part 15 of FCC rules, which are designed to provide reasonable protection against radio frequency interference. Operation of this equipment in other environments may cause interference with radio communications, in which case the user, at his own expense, will be required to take whatever measures may be required to correct this interference.

1.4 If You Need Assistance

Contact your local TI sales representative.
2 Introduction

The Texas Instruments LP5521TMEV evaluation module helps designers evaluate the operation and performance of LP5521 integrated circuit (IC). The LP5521TMEV uses a high-efficiency charge pump, three independent LED channels, and program memory for creating variety of lighting sequences. More information about the LP5521 capabilities can be found in the device datasheet (SNVS441).

The EVM contains power supply connection for the \( V_{DD} \) voltage. Test points are provided for key signals. The on-board microcontroller can be used to control the digital input signals of the LP5521 and to control the device with \( \text{I}^2\text{C} \) interface. A graphical user interface (GUI) is provided for fast and easy evaluation of the device.

If an external power supply is used, \( V_{DD} \) voltage must be within 2.7 V to 5.5 V. This voltage range is within the absolute maximum input range of the LP5521. Users are cautioned to evaluate their specific operating conditions and choose components with the appropriate voltage ratings before designing this support circuitry into a final product.

3 Description of the LP5521

3.1 General Description

The LP5521 is a three-channel LED driver designed to produce variety of lighting effects for mobile devices. A high-efficiency charge pump enables LED driving over full Li-Ion battery voltage range. The device has a program memory for creating variety of lighting sequences. When program memory has been loaded, LP5521 can operate autonomously without processor control allowing power savings.

3.2 Features

- Adaptive Charge Pump With 1× and 1.5× Gain Provides Up to 95% LED Drive Efficiency
- Charge Pump with Soft Start and Overcurrent, Short-Circuit Protection
- Low Input Ripple and EMI
- Very Small Solution Size, No Inductor or Resistors Required
- 200-nA Typical Shutdown Current
- Automatic Power Save Mode
- \( \text{I}^2\text{C} \)-Compatible Interface
- Independently Programmable Constant Current Outputs with 8-Bit Current Setting and 8-Bit PWM Control
- Typical LED Output Saturation Voltage 50 mV and Current Matching 1%
- Three Program Execution Engines with Flexible Instruction Set
- Autonomous Operation Without External Control
- Large SRAM Program Memory
- Two General Purpose Digital Outputs
- 36-pin DSBGA package, 2.478 mm × 2.478 mm × 0.6 mm, 0.4 mm pitch
3.3 **Applications**

- Fun and Indicator Lights
- LCD Sub-Display Backlighting
- Keypad RGB Backlighting and Phone Cosmetics
- Vibra, Speakers, Waveform Generator
- Blood Glucose Meter
- Handheld POS Terminals
- Electronic Access Control
- Where RGB Indication is Needed

3.4 **LP5521 Typical Application Drawing**
Figure 1 shows how to set up shunts on LP5521TMEV. If external $V_{DD}$ supply is used it must be connected to connector J2. Jumper J4 selects supply voltage source. This setup uses on-board microcontroller to control LP5521. LP5521TMEV must be connected to a Windows PC with USB cable. On-board LEDs are used as load.

Jumpers J1, J3, J8, and J9 select if white or RGB LEDs are used.

The LP5521 supports I2C interface. The LP5521 device is connected to the onboard microcontroller through connector J13. If user wants to use own controller to control the LP5521, shunts on connector J13 need to be removed and external controller needs to be connected to the pins on the right side of the J13.
Figure 2 shows main parts of LP5521 EVM. The board has four LP5521 circuits with the necessary external components placed around them. Test points for the signals are on the board edges. INT and TRIG lines for the four chips are tied together to make it possible to synchronize four LP5521 and make interesting lighting effects. GPO and INT pins have indicator LEDs. Each chip has own I²C address.

Jumper J4 on the evaluation board selects supply voltage $V_{DD}$ from either external power or USB power. If external power supply is used, the VDD and ground GND can be connected to the green power connector J2. Possible supply voltage range is from 2.7 V to 5.5 V. When the USB 5-V powering is used, onboard regulator is used to generate a 3.3-V supply voltage.

There are red indicator LEDs connected to the INT and GPO pins to detect the functionality of the pins. With INT LED time it is possible to determine to which external interrupt is sent. Interrupt can be cleared by reading the Status/INT register (offset 0Ch), or by simply pressing the Read Registers button on the evaluation software when the chip which has sent the interrupt is selected. Note that if INT pin is set to work as a CMOS output (EN_GPO_INT bit high) the functionality of the LED is reversed; that is, when GPO_INT is high then the LED is off and when GPO_INT is low, the LED is on. See Section 9 for reference.
5 LP5521 Evaluation Software

5.1 General

The LP5521TMEVM is connected to the computer via USB. The EVM is controlled with special evaluation software. The on-board microcontroller is used to provide easy I²C communication, as well as to control the digital inputs of the LP5521 IC. The microcontroller is powered by default from USB. The LP5521 device can be powered from the USB or from external power supply.

5.2 LP5521 Evaluation Software Installation

Before the LP5521 evaluation software can be used it must be installed. Open the folder containing the installation package and double click the “LP5521TMEV-1.0.0-installer.exe”. If Windows® prompts verification of the installation click “Yes”. The license agreement window opens. Read through the license agreement and click “I agree”. Next the installer prompts for components to install. Select additionally “Desktop Shortcut” if needed and click “Next>”. Then the installer prompts for installation directory. TI recommends installing the program to its default location. Click “Install” button to start installation.

Evaluation software is now installed. To read release notes and/or start an application make appropriate selections and click “Finish” to exit.

5.3 Evaluation Software Uninstallation

Uninstallation of the LP5521 evaluation software is done through the Windows Control Panel. Open Control Panel → Programs and Features. Find LP5521 EVM from the list, right click it and select Uninstall.

5.4 Graphical User Interface (GUI)

When LP5521 evaluation software is run it looks like Figure 3. Main parts of the GUI are:

- Menu toolbar
- Quick access toolbar
- Device controls
- Quick start/ Device/ Code/ Log Tabs
- Register access related controls
- Status bar
5.4.1 Menu Toolbar

Menu toolbar has four sub menus: File, View, Tools and Help.

- File->Load Code: loads source of binary to code editor.
- File->Save Source Code: Saves source code from code editor to a file.
- File->Save Binary File: Saves code from code editor to a file in binary format.
- File->Exit: Exits the application.
- View->Console: Opens console in the right side of the window. See Section 5.4.8 for more information.
- Tools->Direct Register Access: Opens direct register access dialog. See Section 5.4.7
- Tools->Update Firmware: Can be used to update the firmware of the microcontroller on EVM.
5.4.2 Quick Access Toolbar

Quick Access toolbar contains shortcuts to features placed under File menu.

![Quick Access Toolbar Image]

5.4.3 Device Controls

Checkbox “Enable Devices” controls the state of EN signal.
Dropdown menu is used to select to which device I²C commands are sent.
Checkbox “Enable CLK_32K” enables onboard clock signal generator.
Push button “Trigger” send short pulse to TRIGGER input.

![Device Controls Image]

5.4.4 Tabs

There are four separate tabs. See Section 5.4.4.1 to Section 5.4.4.4 for more detailed description.

5.4.4.1 Quick Start Tab

Quick Start tab can be used to quickly load example code files to the program memory or to control directly current and PWM of the LEDs.
Click “…” button to select code file to be loaded for each device and click “Load and Run!” button. The evaluation software is provided with several example programs. They can be found in “program_examples” directory. Some of the examples wait for TRIGGER signal before they start. TRIGGER signal can be toggled by clicking “Trigger” button or pressing button S1 on EVM.

Alternatively LEDs can be controlled directly by using sliders on the lower part of the tab. Each LED has separate slider for current and PWM value. Device to be controlled is selected by dropdown menu labeled “Selected device”. Notice that LED currents can be adjusted while programs are running, but adjusting PWM stops the execution of the current programs.

### 5.4.4.2 Device Tab

Device Tab contains most of the register controls. Change to any control is written immediately to the selected device unless “Auto Write” checkbox is unchecked. Refer to LP5521 datasheet for more detailed information.
On the left side there are controls covering most of the device functions.

**Master Chip Enable**—Enables device internal start-up sequence.

**GPO Pin State**—Controls the state of the GPO pin.

**Logarithmic PWM**—Checking this sets INT pin to function as GPO pin.

**Enable INT pin GPO function**—Selected register is read from the selected device.

**NT Pin State**—Controls the state of the INT pin. (it must be in GPO mode).

**Power-Save Mode**—Enabled power-save mode.

**PWM Clock**—Selects between 256 Hz (source external 32-kHz clock) and 558-Hz clock (source internal oscillator).

**Charge Pump Mode**—Sets mode of the charge pump to OFF, forced bypass mode, forced 1.5× mode or automatic mode.

**R Channel Supply**—Selects between charge pump and battery.

**LED-Controller Clock Source**—Options: external 32-kHz or internal clock or automatic selection.

**Exec Mode**—Selects the execution mode of each engine. Options: Hold, Step, Run and Step, but not increment PC.

**Operation Mode**—Selects the operation mode of each engine. Options: Disabled, Load program, Run program and Direct control.

**PWM**—Sets the PWM value for each output.

**Current**—Sets the LED current for each output.

On the right side are status indicators for interrupt and trigger pin and various status bits.

**INTERRUPT Pin**—Shows the state of the INTERRUPT pin.
TRIGGER Pin—Shows the state of the TRIGGER pin.

Clock State—Shows currently selected clock source.

Interrupt from X Channel—Shows which channel(s) triggered interrupt.

NT Pin State—Controls the state of the INT pin. (it must be in GPO mode).

Power-Save Mode—Enabled power-save mode.

Current—Sets the LED current for each output.

5.4.4.3 Code Tab

The Code tab is divided to source code editor (left side) and binary view (right side). Code file (source or binary) can be loaded by clicking “Load Code” button in Quick Access toolbar or in the File menu. File format is automatically detected. “Assemble>>” button is used for compiling code in the source code editor. Results are shown in binary view. It is possible to disassemble contents of binary view by clicking “<<Disassemble” button. Source or binary code can be saved to a file by clicking corresponding button in Quick Access toolbar.

“Upload to LP5521” button sends compiled program code to selected device.

“Download from LP5521” button reads program code from selected device and show results in binary view.

“Step” button executes loaded code one instruction at time. When code is stepped, instruction pointers of each engine are shown in the left side of the binary view.

“Run” button starts the execution of loaded code. When code is running, it can be stopped by clicking “Stop” button.

For more information about LP5521 assembly language, see Section 8.1.
5.4.4.4 **Log Tab**

The Log tab shows the commands that have been sent to the LP5521. Log can be cleared by clicking the clear Log button.

![Log Tab Screenshot](image)

5.4.5 **Register Access Related Controls**

- “Auto Write” checkbox controls if changes are written immediately to the device or not.
- “Poll Status” checkbox controls if status registers are polled repeatedly.
- “Read Registers” push button reads all registers of the device.
- “Write Registers” push button writes values from the GUI to the device. This is useful only if “Auto Write” checkbox is unchecked.

![Register Access Controls](image)

5.4.6 **Status Bar**

Status bar shows the connection status of the EVM and the status of the last I²C operation.

![Status Bar Screenshot](image)

5.4.7 **Direct Register Access Dialog**

Register map can be opened from Tools menu -> Direct Register Access. This gives an easy way to show content of all the registers. Direct register access can also be used to change the content of any of the registers. Register contents of the selected device are read when Direct Register Access Dialog is opened.
Figure 4. Direct Register Access Dialog

In the top part of the dialog there are the following controls:

**Save**— All registers are saved to a file.

**Load**— Register contents are restored from a file.

**Read Register**— Selected register is read from the selected device.

**Write Register**— Selected register is read from the selected device.

**Selected Register**— Selects the device to be controlled.

**Update Mode**— Immediate = changes are written to the selected device immediately.

**Manual** = “Write Register” button has to be used to write change to the device.
5.4.8 Console

The console window can be used to read and write any of the registers. A register can be read by giving register address, for example 0x00. Register value can be changed by giving register address followed by data, for example 0x00 = 0x05.

Console can also be used to run predefined script files. Script file needs to be located in the same folder as the LP5521 evaluation software. Script files are described with more details in the Script files chapter. Console can be enabled by clicking View → Console.

6 Examples

This section describes how to do some basic operations with LP5521EV software.

6.1 Starting up the LP5521

To start up the LP5521 and to be able to communicate with the device follow these steps:

- Connect and set up the EVM hardware as described in chapter LP5521TMEV Hardware and turn on the power supply if external supply is used.
- Set EN pin high by checking “Enable devices”. LP5521 is now in normal mode and all the registers can be read and written.
- Use “Selected Device” dropdown menu to select right device.

6.2 Set R, G, and B LEDs ON

- Start up the device as described in chapter Section 6.1.
- In Device tab, check checkbox “Master chip enable”.
- Set operation mode for each channel to “Direct control”.
- Set charge pump mode to “auto”.
- Increase PWM values of each LED.
7 Using Scripts

Script file is a text file that contains number of different register write/read operations. Script files also support simple looping, wait command and can take parameters as inputs. Script file can be used to set up LP5521. They can also be used to generate brightness ramps etc.

Script file can be run by typing the name of the script file to the console window. To be able to run the script file it needs to be stored into the LP5521 evaluation software installation folder. If LP5521 evaluation software was installed to default location it can be found in “C:\Program Files\Texas Instruments\LP5521 EVM”.

7.1 Register Access

Registers can be accessed by register name or by direct address. It is also possible to limit access to specific bit field to keep other bits in same register address unaltered.

7.1.1 Example: Read contents of ENABLE register in address 0h.

By direct address:

\[
\begin{align*}
> 0x0 \\
0x0 = 0x6A (0110 1010)
\end{align*}
\]

By register name:

\[
\begin{align*}
> ENABLE \\
ENABLE = 0x6A (0110 1010)
\end{align*}
\]
7.1.2 Example: Write value AAh to R_PWM register in address 02h.

By direct address:

\[
\geq 0\times 02 = 0\times aa
\]

By register name:

\[
\geq R_{PWM} = 0\times aa
\]

7.1.3 Example: Read bit field R_EXEC (bits [5:4]) from ENABLE register in address 0h.

By direct address:

\[
\geq 0\times 0[5:4] \\
0\times 0[5:4] = 0\times 02 ( 0000 0010 )
\]

By bit name:

\[
\geq R_{EXEC} \\
R_{EXEC} = 0\times 02 ( 0000 0010 )
\]

7.1.4 Example: Write 02h to bit field R_EXEC (bits [5:4]) in ENABLE register, address 0h.

By direct address:

\[
\geq 0\times 0[5:4] = 0\times 02
\]

By bit name:

\[
\geq R_{EXEC} \\
R_{EXEC} = 0\times 02 ( 0000 0010 )
\]

When writing to registers or bit fields, values can be given in several formats. The following example shows commands which do effectively same thing.

\[
\geq 0\times 02 = 0\times aa \\
\geq 0\times 02 = aah \\
\geq 0\times 02 = 170 \\
\geq 0\times 02 = 10101010b
\]
7.2 Parameters

It is possible to execute a script with parameters. Scripts can also call other scripts and give them parameters.

7.2.1 Example: Call “example2.txt” script with three parameters.

Example: Call “example2.txt” script with three parameters:

```plaintext
// variables example
// execute this script by giving it parameter:
// example2.txt <time> <addr in hex>
<data>

// input parameters
// $0 wait time
// $1 address
// $2 data to write

wait($0)

$1 = $2
```

It is possible to call script with up to 7 parameters.

7.3 Loops

It is possible to create simple for-loops in script files. Example below shows how to use for-loops.

```plaintext
// for-loop example

// incrementing variable
for i=0:10:100
  wait($i)
end

// decrementing
for i=100:-10:0
  wait($i)
end

// nested loop
for i=0:1:5
  for j=0:10:100
    wait($j)
  end
end
```

7.4 Command Reference
wait(N)
Creates N milliseconds long delay. N can be between 1 and 10000.
example: wait(1000)
8 Command Compiler

Command compiler is used to write LED sequences for the LP5521. It is simple to use tool integrated to GUI application. User can write own memory files by using source editor in Code tab. Compiling can be done by clicking “Assemble>>” button.

8.1 Instruction Reference

8.1.1 ramp

Ramp command generates a PWM ramp from current value. Ramp command has two parameters – first is time in milliseconds (maximum time = 1000 ms x number of steps) and second is number of steps (positive or negative integer, 2-128) separated by comma.

Example: ramp 100,50

8.1.2 wait

With wait command, program execution stops for time defined. Command has one parameter, time in milliseconds. (1-999)

Example: wait 500

8.1.3 branch

Branch command can be used to loop certain sequences in program. Command loads step number to program counter. It has two parameters, loop count (0-63, 0 means infinite loop) and label separated with comma. Label must be defined before using in a branch command. The following example loops 5 times between label1 and branch command.

Example: label1: ...
... ...
branch 5, label1

8.1.4 set_pwm

set_pwm command sets PWM output value. Command has one parameter, PWM value (0-255).

Example: set_pwm 23

8.1.5 start

start command resets program counter and continues executing from the beginning of the section.

Example: start

8.1.6 trigger

trigger command waits or sends trigger. Command has two parameters, wait channel and send channel. Channels are defined as: r = red, g = green, b = blue and e = external.

Examples: trigger sr => Send trigger to red channel
trigger sg => Send trigger to green channel
trigger sb => Send trigger to blue channel
trigger se => Send trigger to external channel
trigger sgb => Send trigger to green and blue channel
trigger wr => Wait for trigger from red channel
trigger sr,wb => Send trigger to red channel and wait for trigger from blue channel.
8.1.7 end

end command ends program execution. Optionally interrupt signal can be sent or program counter can be reset. Command can have up to two parameters. I = send interrupt to INT pin, R = reset program counter.

Examples:
end I
end R
end R,I
end I,R
end

8.1.8 Comment

Comment lines must start with “#” or “/” character.

Example: # red LED section start

8.1.9 Sections

Red, green and blue LED engine sections start with .RED, .GREEN or .BLUE.

Example: .RED

8.1.10 Labels

Any words with colon (:) as last character.

Example: label1:

8.2 Example Code

# red LED section
start
.RED
ramp 20.5,6
ramp 10,-15
wait 10
# green LED section
start
.GREEN
ramp 10,-15
start
# blue LED section
start
.BLUE
ramp 10,15
end R
Figure 5. Top Level
Figure 6. Microcontroller
Figure 8. LP5521 (Device 2)
Figure 9. LP5521 (Device 3)
Figure 10. LP5521 (Device 4)
Figure 11. Top Overlay

Figure 12. Layer 1 (Top, Signal)

Figure 13. Layer 2 (GND)

Figure 14. Layer 4 (Power)

Figure 15. Layer 4 (Bottom, Signal)
## Bill of Materials

The following is the bill of materials for the LP5521TMEV:

<table>
<thead>
<tr>
<th>DESIGNATOR</th>
<th>QUANTITY</th>
<th>VALUE</th>
<th>PART NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1, C7, C15, C22, C25, C29</td>
<td>6</td>
<td>0.1uF</td>
<td>GRM188R71C104KA01D</td>
</tr>
<tr>
<td>C2, C5, C6, C10, C18, C23, C30, C33</td>
<td>8</td>
<td>1uF</td>
<td>C1005X5R1A105K050BB</td>
</tr>
<tr>
<td>C3, C4, C8, C9, C20, C21, C31, C32</td>
<td>8</td>
<td>0.47uF</td>
<td>C1005X5R1A474K050BB</td>
</tr>
<tr>
<td>C11, C13, C19, C28</td>
<td>4</td>
<td>0.01uF</td>
<td>C0603H103J3GACTU</td>
</tr>
<tr>
<td>C12, C16, C17, C26</td>
<td>4</td>
<td>1uF</td>
<td>GRM188R61A105KA61D</td>
</tr>
<tr>
<td>C14</td>
<td>1</td>
<td>2.2uF</td>
<td>EMK212B7225KG-T</td>
</tr>
<tr>
<td>C24, C27</td>
<td>2</td>
<td>10pF</td>
<td>GRM1555C1H100FA01D</td>
</tr>
<tr>
<td>D1, D2, D3, D4, D5</td>
<td>5</td>
<td>Red</td>
<td>HSMC-C190</td>
</tr>
<tr>
<td>D6, D8, D9, D10, D12, D13, D14, D16, D17, D18, D20, D21</td>
<td>12</td>
<td>White</td>
<td>SML312WBCW1</td>
</tr>
<tr>
<td>D7, D11, D15, D19</td>
<td>4</td>
<td>Rgb</td>
<td>ASMT-YTC2-0AA02</td>
</tr>
<tr>
<td>R1, R2, R3, R4, R5</td>
<td>5</td>
<td>300</td>
<td>RC0603JR-07300RL</td>
</tr>
<tr>
<td>R6, R11</td>
<td>2</td>
<td>10k</td>
<td>RC0603JR-0710KL</td>
</tr>
<tr>
<td>R7, R9</td>
<td>2</td>
<td>1.5k</td>
<td>RC0603JR-071K5L</td>
</tr>
<tr>
<td>R8</td>
<td>1</td>
<td>10k</td>
<td>CRCW060310K0JNEA</td>
</tr>
<tr>
<td>R10</td>
<td>1</td>
<td>0</td>
<td>CRCW060300000020EA</td>
</tr>
<tr>
<td>S1</td>
<td>1</td>
<td></td>
<td>B3SL-1022P</td>
</tr>
<tr>
<td>U1, U2, U5, U6</td>
<td>4</td>
<td></td>
<td>LP5521TM/NOPB</td>
</tr>
<tr>
<td>U3</td>
<td>1</td>
<td></td>
<td>TPS73633DRBR</td>
</tr>
<tr>
<td>U4</td>
<td>1</td>
<td></td>
<td>TM4C123GH6PMTR</td>
</tr>
<tr>
<td>Y1</td>
<td>1</td>
<td></td>
<td>ABM3-16.000MHZ-D2Y-T</td>
</tr>
</tbody>
</table>
### Revision History

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

<table>
<thead>
<tr>
<th>DATE</th>
<th>REVISION</th>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>September 2016</td>
<td>E</td>
<td>Complete re-write of user guide.</td>
</tr>
</tbody>
</table>
STANDARD TERMS AND CONDITIONS FOR EVALUATION MODULES

1. **Delivery:** TI delivers TI evaluation boards, kits, or modules, including demonstration software, components, and/or documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance with the terms and conditions set forth herein. Acceptance of the EVM is expressly subject to the following terms and conditions.

1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions set forth herein but rather shall be subject to the applicable terms and conditions that accompany such Software.

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned, or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production system.

2 **Limited Warranty and Related Remedies/Disclaimers:**

2.1 These terms and conditions do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License Agreement.

2.2 TI warrants that the TI EVM will conform to TI’s published specifications for ninety (90) days after the date TI delivers such EVM to User. Notwithstanding the foregoing, TI shall not be liable for any defects that are caused by neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have been altered or modified in any way by an entity other than TI. Moreover, TI shall not be liable for any defects that result from User's design, specifications or instructions for such EVMs. Testing and other quality control techniques are used to the extent TI deems necessary or as mandated by government requirements. TI does not test all parameters of each EVM.

2.3 If any EVM fails to conform to the warranty set forth above, TI's sole liability shall be at its option to repair or replace such EVM, or credit User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day warranty period.

3 **Regulatory Notices:**

3.1 **United States**

3.1.1 **Notice applicable to EVMs not FCC-Approved:**

This kit is designed to allow product developers to evaluate electronic components, circuitry, or software associated with the kit to determine whether to incorporate such items in a finished product and software developers to write software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference. Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.

3.1.2 **For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:**

**CAUTION**

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation. Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

**FCC Interference Statement for Class A EVM devices**

*NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.*
FCC Interference Statement for Class B EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada

3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210

Concerning EVMs Including Radio Transmitters:

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

Concernant les EVMs avec appareils radio:

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated. Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited for use with this device.

Concernant les EVMs avec antennes détachables

Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le manuel d'usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de l'émetteur.

3.3 Japan

3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lds/ti_ja/general/eStore/notice_01.page 日本国内に輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required by Radio Law of Japan to follow the instructions below with respect to EVMs:

1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for Enforcement of Radio Law of Japan.
2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to EVMs, or
3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.
【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けていないものがあります。技術基準適合証明を受けていないものご使用に際しては、電波法遵守のため、以下のいずれかの措置を取っていただく必要がありますのでご注意ください。

1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。

日本テキサス・インスツルメンツ株式会社
東京都新宿区西新宿6丁目24番1号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

4 EVM Use Restrictions and Warnings:
4.1 EVMs ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information related to, for example, temperatures and voltages.
4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or property damage. If there are questions concerning performance ratings and specifications, User should contact a TI field representative prior to connecting interface electronics including input power and intended loads. Any loads applied outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative. During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit components may have elevated case temperatures. These components include but are not limited to linear regulators, switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the information in the associated documentation. When working with the EVM, please be aware that the EVM may become very warm.
4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the dangers and application risks associated with handling electrical mechanical components, systems, and subsystems. User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees, affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or designees.
4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal, state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as accurate, complete, reliable, current, or error-free.
6. Disclaimers:

6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY WRITTEN DESIGN MATERIALS PROVIDED WITH THE EVM (AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED “AS IS” AND “WITH ALL FAULTS.” TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS AND CONDITIONS SHALL BE CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR IMPROVEMENT MADE, CONCEIVED OR ACQUIRED PRIOR TO OR AFTER DELIVERY OF THE EVM.

7. User’s Indemnity Obligations and Representations. User will defend, indemnify and hold TI, its licensors and their representatives harmless from and against any and all claims, damages, losses, expenses, costs and liabilities (collectively, “Claims”) arising out of or in connection with any handling or use of the EVM that is not in accordance with these terms and conditions. This obligation shall apply whether claims arise under statute, regulation, or the law of tort, contract or any other legal theory, and even if the EVM fails to perform as described or expected.

8. Limitations on Damages and Liability:

8.1 General Limitations. In no event shall TI be liable for any special, collateral, indirect, punitive, incidental, consequential, or exemplary damages in connection with or arising out of these terms and conditions or the use of the EVMS provided hereunder, regardless of whether TI has been advised of the possibility of such damages. Excluded damages include, but are not limited to, cost of removal or reinstallation, ancillary costs to the procurement of substitute goods or services, retesting, outside computer time, labor costs, loss of goodwill, loss of profits, loss of savings, loss of use, loss of data, or business interruption. No claim, suit or action shall be brought against TI more than one year after the related cause of action has occurred.

8.2 Specific Limitations. In no event shall TI’s aggregate liability from any warranty or other obligation arising out of or in connection with these terms and conditions, or any use of any TI EVM provided hereunder, exceed the total amount paid to TI for the particular units sold under these terms and conditions with respect to which losses or damages are claimed. The existence of more than one claim against the particular units sold to user under these terms and conditions shall not enlarge or extend this limit.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s) will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s), excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas, without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas. Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2016, Texas Instruments Incorporated
IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, enhancements, improvements and other changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESD48, latest issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and complete. All semiconductor products (also referred to herein as "components") are sold subject to TI's terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI's terms and conditions of sale of semiconductor products. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily performed.

TI assumes no liability for applications assistance or the design of Buyers’ products. Buyers are responsible for their products and applications using TI components. To minimize the risks associated with Buyers’ products and applications, Buyers should provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI components or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services or a warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of significant portions of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied by all associated warranties, conditions, limitations, and notices. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional restrictions.

Resale of TI components or services with statements different from or beyond the parameters stated by TI for that component or service voids all express and any implied warranties for the associated TI component or service and is an unfair and deceptive business practice. TI is not responsible or liable for any such statements.

Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards which anticipate dangerous consequences of failures, monitor failures and their consequences, lessen the likelihood of failures that might cause harm and take appropriate remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use of any TI components in safety-critical applications.

In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI’s goal is to help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and requirements. Nonetheless, such components are subject to these terms.

No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties have executed a special agreement specifically governing such use.

Only those TI components which TI has specifically designated as military grade or "enhanced plastic" are designed and intended for use in military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components which have not been so designated is solely at the Buyer’s risk, and that Buyer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.

<table>
<thead>
<tr>
<th>Products</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplifiers</td>
<td>dataconverter.ti.com Computers and Peripherals <a href="http://www.ti.com/computers">www.ti.com/computers</a></td>
</tr>
<tr>
<td>DLP® Products</td>
<td>dsp.ti.com Energy and Lighting <a href="http://www.ti.com/energy">www.ti.com/energy</a></td>
</tr>
<tr>
<td>DSP</td>
<td><a href="http://www.ti.com/clocks">www.ti.com/clocks</a> Industrial <a href="http://www.ti.com/industrial">www.ti.com/industrial</a></td>
</tr>
<tr>
<td>Clocks and Timers</td>
<td>interface.ti.com Medical <a href="http://www.ti.com/medical">www.ti.com/medical</a></td>
</tr>
<tr>
<td>Interface</td>
<td>logic.ti.com Security <a href="http://www.ti.com/security">www.ti.com/security</a></td>
</tr>
<tr>
<td>Logic</td>
<td>power.ti.com Space, Avionics and Defense <a href="http://www.ti.com/space-avionics-defense">www.ti.com/space-avionics-defense</a></td>
</tr>
<tr>
<td>Power Mgmt</td>
<td>microcontroller.ti.com Video and Imaging <a href="http://www.ti.com/video">www.ti.com/video</a></td>
</tr>
<tr>
<td>Microcontrollers</td>
<td><a href="http://www.ti-rfid.com">www.ti-rfid.com</a></td>
</tr>
<tr>
<td>RFID</td>
<td>OMAP Applications Processors <a href="http://www.ti.com/omap">www.ti.com/omap</a> TI E2E Community e2e.ti.com</td>
</tr>
<tr>
<td>Wireless Connectivity</td>
<td><a href="http://www.ti.com/wirelessconnectivity">www.ti.com/wirelessconnectivity</a></td>
</tr>
</tbody>
</table>

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2016, Texas Instruments Incorporated